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Installing NetMail!
Install NetMail! as follows
1) Uninstall old version.
2) Unzip netmail.zip file.
3) Run executable file setup.exe.
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NetMail! Configuration

After you have installed NetMail!, double-click on its icon to open the program. Before
you can actually use NetMail!, you must give it some necessary pieces of information.
To enter this information, select Preferences... from the Main menu.
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The program provides support and administration capabilities to assist you in managing multiple e-mail
accounts.
To use NetMail!, you must have an account on a computer that runs a POP3 server. This is the account
to which your e-mail messages are delivered before they are transferred to the NetMail! program on your
PC. Inthe User ID field, type your login name for this account. In the Name field, type your real name.
The General Setting provide NetMail! with the minimum user account information
necessary to send and receive mail.
Normally, NetMail! uses your POP account as your return address. If you wish to use a
return address other than your POP account, enter it here.
To receive mail with NetMail!, you must have an account on a computer that runs a Post
Office Protocol version 3 (POP3) server.

To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) server program



is necessary. You need not have a login on this computer, but you must have access to
it through your network.
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Creating an Outgoing Message

An outgoing message is a message you send to someone else.
To create an outgoing message, select New Message from the File menu.
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A new Outgoing message window is displayed with the insertion point situated at the start of the To: field.
Message Header

Outgoing message headers consist of six fields: To:, Subject:, Cc:, Bcc:, and Attachments:. Each field
holds a different piece of information. The To:, Subject:, Cc:, and Bcc: fields can be directly edited.
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To move the insertion point from field to field, press the [tab] key or click in the desired field with the
mouse. When entering information into the fields, you can use the standard Windows text-editing tools
provided under the Edit menu. Here is a brief description of the intended contents of each field:

To:

The intended recipient's e-mail address, or a mailing list you have. Multiple addresses are allowed, but
must be separated by commas.

Cc:

E-mail address of person to whom a copy of the message is to be sent. Multiple
addresses are allowed but must be separated by commas. This field may be left blank.
Bcc:

"Blind" carbon copy. Like addresses listed in the Cc: field, addresses listed here receive
copies of the message. Unlike addresses listed in the Cc: field, addresses listed here do
not appear in the message header of the recipients. This is useful when you want to
send a copy of a message to someone without everyone else knowing you did so.
Multiple addresses are allowed but must be separated by commas. This field can be left
blank.



Addressbook
The addressbook allow to support the respondents database.

Subject:
Brief text indicating the contents of the message. This field can be left blank (though it is
a breach of e-mail etiquette to do so).

Attachments:
List of documents being sent along with the message. Specify these through the Attach
Document command under the Message menu (see the "Attachments" section)
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Message Body

After filling in the fields, move the insertion point to the space below the message header.
of the message here.

Saving an Outgoing Message for Later Changes
Sometimes it is convenient to save an outgoing message either as a safeguard when
typing long messages, or so you can return to it later to edit or add more text.

To save the message while the outgoing message window is open, select Save from the
File menu.
If you now close the message (by clicking the close box in the upper left-hand corner of
the message window, or by selecting Close from the File menu), it can be re-opened
from the Out mailbox for further changes.

Options:

% Standart M ail
Mailing List

NetMail sends one message to multiple recipients.

Standart Mail

i~ Mailing list

NetMail sends personalized message to multiple recipients.

Type the body
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Sending A Message

Select Send Immediately from the File menu to immediately send a current message. Click this button
to send the current message. progress window is displayed momentarily at the top of the screen
indicating the progress of the transmission.
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Checking For and Receiving Mail

The POP server is the machine where your mail is received and stored until it is
transferred to the NetMail! program on your PC. Your POP server account is specified in
the General setting in the Preferences dialog (Tools / Preferences menu).
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There are two methods to check your designated POP server to see if you have new mail. One method
is automatic and the other is manual. Both methods deliver any mail addressed to you from the POP
server to your PC. Before any checks are made, however, the POP server requests your account
password.

Automatic Checking

NetMail! automatically checks for mail if you tell it how often to do so. From the Tools
menu, select Preferences.... Then select Checking Mail. The Checking Mail settings
include an option entitled Check for mail every _ minute(s).
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Type in a value and NetMail! automatically checks for mail at the desired interval whenever it is running
(even if you are using other applications on your PC). For example, if you type in 30, NetMail! checks for
mail every 30 minutes. In fact, 30 minutes is a good minimum interval, as checking mail more frequently
puts an unnecessary load on your POP server.

If the In mailbox is not already open, select In from the Mailbox menu.
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Unread messages are designated by a bullet ( . ) in the far left column of the message summary.
Double-click anywhere on a message summary to open the message. Incoming messages are saved
indefinitely in the In mailbox until they are deleted or transferred to another mailbox.

Manual Checking

You may check for mail manually at any time by selecting Check Mail from the File menu. If you haven't
successfully entered your password since opening the NetMail! program, you are prompted for it.
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A Progress window is displayed momentarily at the top of the screen as the POP server is checked.

If there is a problem reaching the POP server, an error message alert is displayed. To rectify the

problem, review the POP server field in the Preferences dialog for correctness.

If there is no mail waiting at your account on the POP server, the No New Mail alert is displayed. Click

OK. You may check for mail again later.

If there is new mail, it is transferred automatically from the POP server to NetMail! on your PC. A

progress window is displayed at the top of your screen allowing you to monitor the mail transfer.
Depending on your settings, the In mailbox window may display. Mail arrives in the In
mailbox. Unread messages in the In mailbox are designated by a bullet (.) in the far left
column of the message summary. Double-click anywhere on a message summary to
open the message. Incoming messages are saved indefinitely in the In mailbox until
they are deleted or transferred to another mailbox.

Stopping a Mail Check
If you want to stop a mail check in the middle (because it is taking longer than
anticipated), click the Stop button in the progress window.
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Creating a Mailbox

To create a new mailbox, select New... from the Mailbox menu. The New Mailbox
Dialog is displayed.
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Type in the new mailbox name and click OK. The mailbox is created and added to the Mailbox and
Transfer menus.
You can also create mailboxes using the Mailboxes window under the Windows menu (see the
"Mailboxes Window" section). The Mailboxes window is most useful if you want to create several
mailboxes at one time.
Creating a Mail Folder
NetMail! allows you to create mail folders in which you may keep one or more mailboxes and even other
subfolders that hold additional mailboxes. In other words, not only can mailboxes be organized into
folders, but folders can be contained one within another.
To create a new mail folder, select New... from the Mailbox menu. The New Mailbox
Dialog is displayed. Type the name of the new mail folder and check the Make it a Folder
option. Click OK to create the folder.
The new folder name is displayed at the bottom of the list of mailbox names under the
Mailbox and Transfer menus. There is an arrow next to the name designating it as a
folder and not as a mailbox. You cannot transfer messages into this folder, however,
since messages must be in mailboxes and you have not yet created a mailbox within the
folder. Therefore, the New Mailbox Dialog is displayed again. Now, type the name of
the mailbox you want to create within the newly-created folder and click OK.
Creating a Mailbox Within a Folder
To create a new mailbox within a particular folder, select that folder from under the
Mailbox menu and choose New... from the submenu that is displayed. The New Mailbox
Dialog is displayed. Type in the new mailbox name and click OK. The mailbox is
created and added to the Mailbox and Transfer menus. You can also create subfolders
in the same manner. Just check the Make it a Folder option.
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Opening a Mailbox

To open a mailbox, select the desired mailbox from the list of mailboxes under the
Mailbox menu.
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To open a "nested" mailbox (one that is contained within a mail folder), select the outermost folder from
the Mailbox menu (folders are designated by an arrow next to their names). This displays the submenu
of mailboxes and/or folders within the outer folder. Select the desired mailbox (or continue selecting
subfolders until the mailbox can be selected).
If any messages are stored in the mailbox, they are listed as individual message
summaries. Each message summary is divided into six columns: Status (S), Sender
(Who), Date, Size (K), and Subject.
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Mailbox Window

Mailbox windows consist of a title bar and list of message summaries.

Message Summary Columns

Content

Each message summary is divided into six columns: Status (S), Size (K), Who
(Sender/Recipient), When (Date - Time), and Subject.
The Status column displays the message status, which is one of the following:
The message has not been read (all mailboxes except Out), or is
queueable but has not been queued (Out mailbox only).
<blank> The message has been read (all mailboxes except Out), or is not yet
able to be queued because it has no recipients (Out mailbox only).
R Reply has been chosen for the message.
S The message has been sent (outgoing messages only).
The "Who" column shows the sender of the message (for incoming messages) or the
recipient or intended recipient (for outgoing messages).
The "When" column displays the date and time the message was sent, or, for timed
messages, the date and time the message is scheduled to be sent.
The "Subject" column displays the subject of the message. The sender originally typed
this information into the message header, but it can be modified by you (see the "Editing
Message Subjects" section).

ghatzviewi@m] webjump. com 02.09.9914:20:.06  |wista.webjump.com 3/2/99 Statistics




Incoming Message Window

To open a message, double-click on its message summary, or, if the message summary
is current , press the View button. The incoming message window is then displayed.
The incoming message window consists of the title bar, and the message body.
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Deleting a Message

As a safeguard against inadvertent deletions, two steps are required to delete a message in
NetMail!. For any current message, choose Delete from the Message menu. This does not
actually delete the message, but transfers it to the Trash mailbox.
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Transferring a Message to a Different Mailbox

Messages may be transferred between any two mailboxes. For any current message,
select the mailbox to which the message should be transferred from the Transfer menu.
The message is transferred from its previous location to the selected mailbox.

Type in the new mailbox name and click OK. The mailbox is created and added to the
Mailbox and Transfer menus. The current message is also transferred into the new

mailbox.
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Mailboxes

Content

Mailboxes and mail folders provide a structured way for NetMail! users to organize
received messages. The Mailboxes window allows you to create new mailboxes and
folders and to remove and rename them. You may also want to move mailboxes and
folders from one folder to another one.

Double-clicking on any of the mailboxes in a list opens that mailbox window on the
screen. Individual messages can be selected, opened, and otherwise manipulated from
there.



Attachments

Any file can be attached to and sent with a NetMail! message. To attach a file to a

current outgoing message, select Attach File from the Message menu.
dialog is displayed. Once the desired file is located, select it and click on the OK button
to attach the file to the message.

When the message is sent, the attached file is formatted according to the selection in the

Attachment Type combo box in the message icon bar (see the "lcon Bar" section).
Multiple Attachments
Multiple files may be sent with a single message, but each file to be attached must be
selected as described above.
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Replying to Incoming Message

Replying to a Message
To reply to a current message, select Reply from the Message menu. A new message
window is displayed, with the original sender's address automatically placed in the To:
field of the header. The original sender's text is also automatically included at the
beginning of the reply message (prefixed by ">" at the beginning of each line). This
text may be edited or deleted as needed.  Additional text may be entered into the reply
just as in any outgoing message. The reply can then be saved for further changes, or
simply sent.
An incoming message for which the Reply command has been used is identified by an
"R" in its message summary.

Modified Forms of Reply
If the Put original To: recipients in Cc: field option in the Settings dialog (Replying) is
turned on, the addresses of the original message recipients are moved from the To: field
to the Cc: field of the Reply to all message. Only the address of the original sender is
placed in the To: field.
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Finding Text Within Messages and Mailbox.

NetMail! incorporates a Find function that searches for specific text within a single
message, multiple messages for selected mailboxes. To display the Find submenu of
commands, select Find from the Edit menu.

Finding Text Within One Message

To search for text within a single message, open the message and make sure it is
current. Then, select Find from the Edit menu and select the Find command from the
submenu. The Find dialog is displayed, with the blinking insertion point located in the
text field.

Type the text you want to find in the text field. When finished entering the desired text,
click the Find button.

Starting at the beginning of the open message, NetMail! searches the current message
for the specified text. If no match is found, the not found alert is displayed.

To continue searching in the same message for the next occurrence of the text, click the
Find button in the Find dialog, or select the Find Again command from the Edit menu.
These commands are equivalent and limit the search to the same message. Repeating
these commands cycles through the matches in the open message only.

Match Case

Normally, NetMail! ignores capitalization when searching. If you want NetMail! to
consider capitalization when searching, check the Match Case option in the Find dialog.
When this option is checked, NetMail! searches for exact matches of character strings,
including any capitalization.



Sorting Messages Within Mailboxes
It is possible to sort the message summaries in a mailbox window according to the contents of
any of the message summary columns. To do this, first open the mailbox to be sorted, then
select the appropriate command from the Sort submenu under the Edit menu. The messages

are sorted when the mouse button is released. NetMail! sorts in ascending order; the smallest
item first.
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Address Book

NetMail support the address book of the email database (email, URL, company name and
other data of your respondents). NetMail's "Import" and "Mail Merge" options let you
send personalized messages to multiple recipients. It can also extract e-mail addresses
from TXT, DBASE, and Paradox files.
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Address book data can be presented in two modes :
¢ The form
e The table

l'._.'i
Fal
G-

To add new addresses press button "+"  after data entering press button  "J"

If the option: "To add data in an address book automatically" (in Preferences dialog) is checked, then
email addressed will be added into addressbook automatically for all incomming and outgoing messages.

The button "Messages" - allows to look all messages related to given address.
The address data can be imported into the address book. For this purpose press thr button - Import .

Further by right button of the Mouse on the right and left panel it is necessary to specify
correspondence between fields of the tables and to mark this correspondence by a button
(with arrow) between these panels. After the correspondence is placed the button -
import will light up. Press it for data import.

Find Dialog
By this dialog you can find by any presented fields the necessary address. For creation of
the list of dispatch use at first button: "select", then press the button "save as".

Mailing List

When at new message preparation the option

If "Mailing List" option is enable at new message creation, you can select group of
addresses from your address book for mailing list. In this mode you can use address
book data to merge with message greeting. Mail Merge options let you send personalized
messages to multiple recipients. Setting up this option in the Preferences dialog.

The button "Select" of the mailing list will appear in a upper left corner of the address



book.

The data can be filtered and blocked for dispatch by two ways

1) Set up the property - "Blocked Address" for the address
2) Place the address into - "Stop List Database".

In the second case press the button "To block addresses”

Mail Merge options



Mailing List Exceptions

The operation with mailing list exceptions addressbook (addressbook of the blocked
addresses) is similar to operation with a usual addressbook. The data also can to be
imported or entered manually.

The data can also be located in correspondence with filter rules defined in Filters - menu
(look section - Filter).



Import of email addresses

As a rule any user already has own databases of the clients, friends, partners on business
etc. It is possible to import of data from ASCII format, DBF and DB (Paradox)
automaticaly. To prepare data you can use, for example, HTML, TXT - Analyzer.

In further it is enough to specify mutual correspondence of fields and to make import of
data. Use the right button of the Mouse on the right and left panel and button with arrow
below between the right and left panels.




Tools

In this choice it is possible to adjust the order of filtering and data processing.

Filter

Apply Filter
Mailboxes
Preferences
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Filter

You can filter data depending on a subject of the message and text, contained in it.
f™ 3
‘ . J

Depending on customizations of the filter you can:

1) move the messages to mailbox

2) prepare and send by email the answer

3) add address to the address book and selected mailing list
4) delete the address from the mailing list

5) send the message to other email address

6) delete the message

Consistently you can impose different filters on the same mailbox.
Apply Filter

To select "Apply Filter" menu item the filter will be applied. You can also in Preferences
Dialog to customize the automatic filtering after email message getting.
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Preferences

The Settings dialog allows you to configure NetMail!. To display the Settings dialog,
select Preferences .. from the Tools menu.

The Preferences dialog contains the following categories of settings and options:
General, Options, Greeting and Signature, MIME Setup

General Settings
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General | Options I Greeting & Signaturel MIME Setlp I

The General Setting provide NetMail! with the minimum user account information
necessary to send and receive mail.

On the first page of this mode you can place some variants of customizations for email
message reading and email message sending.

That line with customizations where is a cursor and will be current for operation with the
email.
For input of new parameters press button: "+" , after filling data press button: "v"
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That the changes have remained in force it is necessary to leave with saving of changes
Name:

Enter your real name here. ltis placed in the From field of your outgoing mail
messages, along with your return address.

Return address:

Normally, NetMail! uses your POP account as your return address. If you wish to use a
return address other than your POP account, enter it here.

Hosts Settings

The Hosts settings provide NetMail! with information about your servers.



POP Server:
To receive mail with NetMail!, you must have an account on a computer that runs a Post

Office Protocol version 3 (POP3) server.

User ID
Enter your login name.

SMTP:

To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) server program
is necessary. You need not have a login on this computer, but you must have access to
it through your network. Otherwise, specify the name of the computer that you want to
use as your SMTP server.

Options Settings
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The Options settings determine how NetMail! checks for and receives your incoming mail

messages.
Check for mail every ___ minute(s)

If you enter a number in this field, NetMail! checks your POP server for new mail at
regular intervals and transfers any mail addressed to you to your PC. The number you
enter specifies the number of minutes between checks of the POP server. It's a good
idea to set this at no less than 15 minutes This option only works when NetMail! is

running.

—Getting kail

v Check for neve mail on program starbup

v Taoblock

[T Check far new mail every

[T Apply filter after mail checking immediatl.

[ Delete mail fram server

IU rinbes.

the email addresz [if there iz in stop list database].

—Sending Mail charzet——

¥ Save zent messages in Out mailbox = "uz-asci

General " 0
i+ -1251

v Shaow spstem information. Hin

Web browser: Erowsee | 0 Mkaig"

Mew Addres

¥ &dd unique E-mail addrezses anly.

¥ &dd E-mail addreszes automaticly.

Save & Exit Cancel & E=it

Keep copies of outgoing mail

If this option is

on, a copy of each sent message is kept in the Out mailbox (their summaries are marked

with an "S" in the Status column of the Out mailbox window).
outgoing messages to the Trash mailbox after they are sent.
Greeting and Signature Settings

If this option is off, NetMail! moves

These settings control Mail Merge options and miscellaneous functions.
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Use signature

If this option is on, NetMail! automatically attaches your signature to the end of outgoing messages and
greeting according to addressbook database.
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NetMail! Menu Commands

File
This menu provides basic file and mail program functions.

New Message

Open new message composition window.

Reply

Reply to the sender of the current message.

Send Again

Resend a message rejected by the mail system. Be sure to fix whatever caused the problem
before you queue the message.

Send Immediately

Save the message in the Out mailbox and send it immediately.

Send Queued Messages

Send all messages that have been queued for delivery.

Check Mail

Pick up new mail from the POP server. The time in parentheses (if displayed) indicates the next
time NetMail! will automatically check for mail.

Attach File...

Attach file(s) to the current message.

Close

Close the current window.

Save

Save changes to the contents of the topmost window. This applies to composition windows
Delete

Transfer the current message to the Trash mailbox; also used for deleting messages from the
Trash mailbox.

Print...

Print the current message(s),

Exit

Exit the NetMail! application.

Edit

This menu provides text editing and sorting tools.
Undo
Reverse the last editing action taken on a piece of text.
Cut
Delete selected text and place it on clipboard.
Copy
Copy selected text and place it on clipboard.
Paste
Place contents of clipboard at insertion point.
Clear
Delete selected text.
Select All
Select entire contents of message or mailbox.
Find

Search for designated text or character string within message(s).
Sort submenu
Sorts message summaries in a mailbox. Hold down the [Shift] key to reverse the order of the sort.

Mailbox
This menu lets you open a mailbox, or bring an open mailbox to the front.
In



Open mailbox where incoming messages are stored until deleted or transferred to another mailbox.
Out

Open mailbox where messages you compose are stored, and where queued messages are held
until actually sent, and where copies of sent messages may be initially stored.

New...

Display New Mailbox dialog to create a new mailbox.

[Your Mailboxes]

Mailboxes you create are also displayed in this menu.

Transfer
This menu lets you transfer current message(s) to the selected mailbox.
In
Transfer the current message(s) to the In mailbox.
Trash
Transfer the current message(s) to the Trash mailbox.
New...
Display New Mailbox dialog to create a new mailbox. Current message(s) may be transferred into
it.
[Your Mailboxes]
Transfer the current message(s) to the selected mailbox that was previously created by you.
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http://www.internet-soft.com

The Vista team is made up of highly skilled mathematicians, systems
analysts and programmers who, having worked in a

wide variety of financial institutions, have an unsurpassed depth of
knowledge of the economy and its procedures.

We combine this experience with the latest technology in order to bring
you the best possible tools with which to analyse and participate in the
markets.

We invest heavily in market research and systems development in order
to allow our developers to pro-actively respond to the needs of the
marketplace and our clients in a rapidly changing environment.

The Vista company has pioneered the development of high-tech
analytical systems with a solid theoretical base in modern investment
theory for financial institutions, banks and others and is a market leader
in this sector.

Vista is committed to providing value for money services for the custom
development of software and hardware solutions in your business. We
specialise in the automation and computerisation of accounting systems
and other complex financial and investment software. We have already
designed, developed and installed systems for computerising 80
private pension fund management systems (which corresponds to over
1000 sites). We are also involved in providing support for specialised
hardware devices utilised in the financial services industry.

Our favoured development environments are C++ and Delphi. We
endeavour to provide a high quality service at a reasonable price.

Please do not hesitate to request a quotation for any special need which
you may have - You will be pleasantly surprised by our terms. We
especially aim for long-term and mutually advantageous commercial
relationships with our client companies.

To familiarise yourself further with our company and our products,
please visit our web site at http://www.internet-soft.com
Email: info@esalesbiz.com
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Custom evelopment

Vista Custom Development Department.

Since 1993, Vista has provided custom software development services for
businesses engaged in a variety of industries including banking, finance,
investment, manufacturing, education, advertising, research, and
telecommunications.

Our objective is to provide the very best in software technology, service
and support. We are a group of highly skilled professionals providing
consulting services through a number of targeted divisions.

Vista has the talent and resources to produce comprehensive applications
embodying client/server techniques across a range of technologies to
support your business objectives. Vista is uniquely positioned to cover the
entire solution development cycle, from creating a simple custom
application to providing project management services for large-scale
development efforts.

We have extensive experience with the entire development life cycle
including:

Process Analysis

Requirements Definition

Project Planning

Technology Assessment

System Analysis and Design

Rapid Prototyping

Application Development

Application Support

Our expertise in the development of custom applications stems from our
comprehensive understanding of a wide range of advanced technologies,
our diversified programming skills and our exceptional software engineering
capabilities.

To stay competitive, you're constantly searching for better ways to
orchestrate the flow of information. We can get the people in your
company working together like never before. Not by just adding more
computers, necessarily, but by helping realign your information systems
with your organizations goals and objectives. You will then have the ability
and flexibility to react quickly to changing conditions and customer
demands.



The Vista provides the highest possible value for the client, plus a fulfilling
career and positive environment for our team members.

Because we believe that the quality of product deliverables is directly
correlated to the way the development project is managed, we've built a
project management team exceptionally skilled at optimizing productivity.

Vista has experience in the design, development, and implementation of
database-oriented applications ranging from standalone single-CPU
packages to networked client/server designs crossing multiple operating
system platforms. Vista programmers use the latest tools and techniques
in database applications design and are fluent in all current development
environments, such as Delphi, C++ and Java.

At the conclusion of the development cycle and prior to delivery of your
product, bug finding and fixing rather than development become the
primary focus. After the creative process of finding development solutions
and after your application has been appropriately coded, it is tested,
debugged, tested some more, then tested again.

Our team environment flattens the learning curve; we share knowledge and
experience to help each other become as productive as possible. In return,
the client gets the highest level of skills for the services they require.

Why outsource development?
Improve your business processes and boost productivity.

Introduce an otherwise unavailable depth of expertise by hiring a company,
not just a programmer. Our team of professionals is not only thoroughly
trained in Client/server technologies, but they also have the business
experience to help you completely re-engineer your business processes.

Generate revenue by marketing your branded applications.
Key Benefits of a Custom System

Software & Systems Customized exactly to your specification.
Ability to add or change software and systems when your business
needs change.

Since we designed systems around your business, your learning
curve will be smaller.

Why choose Vista to develop your software solution?

Vista has developed a comprehensive and proven method for designing,
developing, and delivering systems that capitalize on new technologies.
The result is a uniquely integrated effort that provides maximum use of
resources.

Vista employs superior project management and establishes a quality
assurance program incorporating predetermined reviews throughout the life
of the project. We focus on customer requirements and correctly
translating those requirements to system architects.

Vista has extensive experience producing profoundly effective results in



Client/Server solutions, data conversions, workflow automation,
programming, system integration, project management, documentation,
and training.

Contact our Custom Development Department with information about
your custom development needs.

http://www.internet-soft.com
Email: info@esalesbiz.com
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Vista Affiliate Program

Earn cash by linking to Vista Products!
Vista is now offering an affiliate sales program. Here is how it works.

If you have a website, you link to us as an affiliate. Users clicking the link
from your site have the option to buy or try Vista Products. If they buy
immediately, or buy later, you can earn 30% of the sale. Our early affiliates
are seeing very good results, so sign up now.

1) The first step is to visit http://www.internet-soft.com.ru/partner.htm and learn about being an
affiliate.

2) Add the following programs:

Shareware

FTP Navigator.

Word Report Builder
Excel Report Builder
Word Report Components
HTML , TXT Analyzer
Domain Quester

NetMail Merge

3) Once you signup to create your affiliate account, visit

http://www.sellshareware.com/AffiliateProgramPage.asp?ProgramID=10610
This page will point give you the image and link instructions needed to start
right away. For each FTP Navigator purchase you help generate, you'll get

30%.

If you have any questions, let us know at info@esalesbiz.com






